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  Welcome to WinSince

WinSince is a customizable file processing utility that allows you to look for files created on or after a 
particular date. It can look for these files in a single directory, in subdirectories, or across entire multiple
drives.  You can also clear the date requirement and search for all files of a particular type, such as 
*.tmp.  You can then print a list of the files found, or perform a customizable Action on some or all of 
the files. 

At it simplest, WinSince will help you find files. But by using the definable Actions, WinSince becomes
an iterative program launcher, running both Windows programs and DOS functions and programs. 

Its combination of graphical presentation and command line flexibility make it an excellent tool for 
power users and networkers. When customized for a particular person, its point and click useability 
make it an excellent end user tool.

WinSince features include:

12 definable File Type buttons, which you can set to any file type and make permanent.

The file Date to check for can be easily set using the VCR-style controls, or entered directly.

Files matching the File Type (and Date if required) are listed with their creation date, size, 
attributes and path.

10 definable Action buttons, which can run both Windows and DOS programs. Into an Action you
can pass the path, complete file name, 8 character file name, and file extension.  For each Action 
you can define the caption on the Action button, the Window format (maximized, minimized, etc.)
and if a warning is to precede the Action.

You can start a program by double clicking on a file name.

Help Topics available:

Quick Start
Using File Buttons
Selecting the Date
Editing and Using Action Buttons
Double Clicking to start a program
Options menu
Hints and Examples
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  Quick Start
This section gives a quick tutorial on the major WinSince features. It is intended for 
first time users. WinSince uses normal Windows conventions, so previous experience 
with moving between directories and selecting files from a list will be useful. See the 
other Help sections for detailed help.

For the tutorial flow to be correct, follow the steps right after starting WinSince. The 
tutorial will suggest what to click the mouse on at a particular time.

A Quick Tour of WinSince

The main WinSince Screen

When WinSince starts the current drive and directory will be shown in the top right of 
the screen. You can change to a new directory by double clicking on a subdirectory 
name.

Beneath the directory boxes is the File Type button section, which has 12 definable 
buttons. Click on the one that has the caption *.exe. The Directory total file list 
(middle top of the screen) will show the number of .exe files in the current directory. 
Click on the *.* button and see how many files there are in total.

The date that WinSince will use while searching is the Find Since date, shown on the 
middle left of the screen. Right now it will show today's date and the word Today to the
right. Under the Find Since date are the VCR-like controls to change the date. Click on 
the < Day button to move back a day to Yesterday. Press the Today button to return to 
Today's date. This is fun !

The big button with the colorful icon in the middle of the screen will say Get Files 
because you have changed the type of files to look for. Click on the Get Files button. 
WinSince will fill the Files Changed list box in the top left of the screen with any files 
changed today (because the File Type is *.* and the Find Since date is Today). The big
button will change to Have Files. If the Files Changed list box is empty then no files 
were changed in this directory today.

Click on the Clear Date button: the date box will now say No Since Date, which tells 
WinSince that it should not worry about the file creation date when searching for files. 
Click on the Get Files button. This time there will likely be files in the top left list box 
(unless your directory is empty, in which case you need to double click your way to a 
busier directory) and it will have a title that begins with No date selected.



The file details shown are:  the name of the file, its creation date (in MM-DD-YYYY 
HH:MM:SS format), its size in bytes, any attributes (such as a for archive, r for 
readonly, h for hidden), and the full path of the file.

Click on any one of the files. It will show in reverse video. Click on the Dir button 
found at the bottom of the screen. The Dir button is one of the 10 definable Action 
keys. You will see a DOS box appear and the DOS Dir command will be run on the file 
you selected. After the command is completed, you will see a Press a key when 
ready... request in the DOS box; this pause is built into the Dir Action definition, which
you will see soon. Press return to complete the Action.
Next, look at the section above the Action buttons on the left. This section lets you 
choose whether you will search for files in the selected directory, down into 
subdirectories, or across entire drives. 

Next to the Search entire drives radio button is a listing of the drives that are available 
to you, such as a:  b:  c:. Click on the box to the left of your hard drive's letter, then 
click on the Free Bytes button on the lower right of the screen. In the box below you 
will see the number of bytes free on this disk and the percent free. You can select 
multiple drives and click on the Free Bytes button to give you a total. This can be very 
handy for checking total disk space available.

The Set Type button is found on the right beneath the File Type buttons. Click on the 
Set Type button. A small form will overlay the File Type buttons. Click on one or more
of the small buttons, and watch the button's file type change to the current File Type to 
Set (*.*). This is fun ! If you make a mistake then press the Reset button to restore the 
values. Pressing the Cancel button will exit the button-setting form without changes; 
pressing the OK button will change the values on the main WinSince screen. Changed 
File Type buttons can be saved from the File menu or when you Exit the program 
(bottom right of main WinSince screen). 

The Edit Screen

The last major section to examine is the Edit menu item. Click on the Edit item along 
the top of the main WinSince screen. The Define Action Keys for WinSince editing 
form will appear.

There are two areas in the Edit screen. At the top is a list of summarized Actions and 
at the bottom is the actual editing area. Click on the Action 2  Dir item in the top 
section. It will change to reverse video, and the lower editing area will change to reflect 
the components of this Action.

For the Dir command you will see that the Action to Do is dir %p\%f. The %p refers 



to the path and the %f refers to the file name. When the action is actually run on a 
selected file WinSince will replace the %p and %f placeholders to yield a real directory 
command, such as dir c:\windows\win.ini (path=%p=c:\windows and file=
%f=win.ini). 

Notice that the Windows or Dos check box is empty because the Dir command is a 
DOS command, not a Windows program. When you start defining your own Actions, 
they can be DOS commands and programs, or Windows programs. 

By setting the various fields you can modify the selected Action to do just about 
anything. A more thorough explanation of Action editing can be found in the Editing 
and Using Action Buttons help section.

Click on the Exit button in the Edit screen. This will return you to the main WinSince 
screen.

To exit the WinSince program, click on the Exit button in the bottom right of the main 
WinSince screen.

   Finding Files and Using the File Buttons

When WinSince starts, it defaults to finding all files changed today in the current directory. Above the 
main file list box (top left) will be shown the number of files found, the date being checked, and the 
type of search. 

When a search is complete the large central button will read "Have Files". Whenever you change the 
file type or date the button will read "Get Files", which WinSince will do when you press the button.

There are 3 file search options you can select:

1) Search selected directory:  This is the default mode, searching only the directory selected using the 
drive and directory selection controls.

2) Directory and Subdirectories:  This begins the file search in the current directory and includes any 
subdirectories under the current directory.

3) Search entire drives:  To use this option, select one or more drives to search. These drive selectors 
are shared with the Free Bytes function.

The drive and subdirectory selection controls operate in the standard Windows manner. The "Directory 
total" file list box shows the names of files matching the File Type in the current directory, irrespective 
of the Date selected. Single clicking on a file in this list will show the file details of this single file 
below the main file details list box.

Under the subdirectory control is the File Type text box. You can directly enter the file type here, such 



as HELLO.* or you can click on one of the 12 file type buttons. You can use the * (multiple character 
wild card) and ? (single character wild card) symbols as accepted by DOS.

Defining your own File Type Buttons

To define your own File Type button, press the Set Type button. A small form ("Set File Button") will 
overlay the existing file buttons. You can edit the "File Type to Set" file name as needed. To set a 
button to the File Type to Set file name just click on one of the 12 buttons. It's fun! Press the OK 
button to accept the new file buttons, or Cancel to return without changes. The Reset button will reset 
the file button values to those when you entered the form. 

You can make your File Type button changes permanent by using the File menu Save File Buttons 
menu selection. You will also be warned if you are about to exit without saving new Button types.

The Free Bytes button is used to determine the amount of free disk space remaining on your disk 
drives. Before clicking on the Free Bytes button select one or more disk drives in the Search entire 
Drives section. When you click on the Free Bytes button it will check all selected drives, including any 
floppy drives you selected. The free space in bytes and as a percent of the total available space is 
shown. Because Free Bytes uses the same disk drive selectors as the file search across drives, you 
should check which drives you have selected before pressing the Get Files button to find files.  



  Selecting the File Date 

Next to the "Find Since" prompt is the Date text box. You can directly enter the date here in MM-DD-
YYYY format, or use the VCR controls to move forward or backward by a Day or Week at a time.  The 
adjacent text box shows the date offset, relative to today (ex. Yesterday).

For example, to select files created since January 20, 1991 the date field would appear as 
01-20-1991.

The Clear Date button will let you look for files without regard to their creation date. This is very 
handy for finding all files of a particular type.

The Save Date button stores the current date for later retrieval with the Reset Date button. If you find a 
date that shows important file activity you can use the Save Date button, then change the date to look 
more, knowing that you can get back to the files for the previous date by pressing the Reset Date and 
Get Files buttons. 

When WinSince starts, it defaults to Today.

   



   Editing and Using the Action Buttons

In many instances, just having a list of files matching a date and file type is enough. But other times you
will want to perform actions on some or all of the files found. The Actions available in WinSince can be
both Windows programs and DOS functions and programs.

To select a single file to act on, click on the file name in the main list box. To select multiple files, hold
down the Control key while you select additional files, or hold down the Shift key to select all files up 
to the file clicked. You can select all files using the All button, and unselect all files using the None 
button.

There are 10 definable Action keys located along the bottom left of the screen in two rows.
To view the current set of Actions enter the Edit menu option. The list box shows the descriptions of 
the 10 Actions, as well as the Cut Buffer. 

The Action Caption can be up to 10 characters long. 

The Action to Do can be up to 100 characters long. It can be a DOS command or program (such as 
COPY or FOX.EXE) or a Windows program (such as EXCEL.EXE). Special substitution symbols allow
you to pass the selected files to the Action in very flexible ways:

%P Path Substitutes the path, excluding the ending \
%F Filename Substitutes the 8 character name, the period, and the file extension
%N Name Substitutes only the 8 character name, with no period
%E Extension Substitutes only the 3 character file extension

Example: If the file list shows an entry for C:\WINDOWS\FILE.TXT, and the Action is
COPY  %P\%F  A:%N_2.%E you would get a resulting command of
COPY  C:\WINDOWS\FILE.TXT  A:FILE_2.TXT

I.e. %P is C:\WINDOWS (note how the ending \ is added)
%F is FILE.TXT
%N is FILE
%E is TXT

Click on an Action in the Action list box to begin editing it. When done, click on the OK button; the changes 
will then appear in the Action list box and be ready for use. The caption will also be changed on the 
corresponding Action button in the main WinSince window. The Cancel button will cancel the changes if the 
OK button has not yet been pressed. You can use the Copy button to copy a selected Action to the Cut Buffer. 
The Paste button will copy the contents of the Cut Buffer to a selected Action. The Exit button returns you to 
the main WinSince screen.

The Window Format will usually be Normal, Show Minimized or Show Maximized.



The Run Windows Program check box should be selected to run a program requiring Windows. For 
DOS commands and programs leave this box unchecked. 

DOS Actions are best run using the DOS Batch File, which uses the SINCECLS.PIF file to run the 
Action in a windowed DOS box, and to close the Window when done. You can use the PIF editor to 
modify this to use Full Screen, etc. as required. If you do not use the DOS Batch File option then each 
iteration of the Action on a list of files will create a new DOS box under Windows, usually causing you 
to run out of memory. By using the DOS Batch File, a single batch file is created (SINCETMP.BAT in 
the TEMP directory) that needs only a single DOS box to run.

If you check Pause between DOS Actions then a DOS Pause command is inserted between each action
in the batch file.

If you check Pause at end of DOS Batch then a DOS Pause command is inserted after the last action in
the batch file. If you do not specify the pause at the end then the window will close when the action is 
completed, which is useful if you run a minimized action that you don't want to see the final status of.

The Warn before Starting check box will present you with a message box before the Action is 
performed on a selected file. If you select No then the next selected file will be presented. If you select 
Cancel the action is ended for all selected files. For DOS Batch File actions a single warning is given 
before the batch file is started, showing a sample action contained in the batch file.

For Windows actions there is no direct parallel to the pause ability of the DOS batch file. Instead, you 
can check the Warn before Starting box. Before the action is started on the next file you will be 
presented with the Warning box. Ignore the Warning box and click on the Windows application. When 
you finish the application the Warning box will still be there. You can then progress to the next file, or 
cancel subsequent actions.

You can make your Action button changes permanent by using the File menu Save Actions menu 
selection. You will also be warned if you are about to exit without saving new Actions.

Note: if you make an error while editing an Action, exit WinSince without saving the changed Action 
definitions. When you restart WinSince the previous actions will be there.



   Double Clicking to start a program
You can start any executable program (.exe, .com, .bat, .pif) by double clicking on its 
name in either the directory file list or the selected files list box. You can also start the 
associated program for the file's extension (such as starting NOTEPAD.EXE when you 
double click on README.TXT).
You can set the Warn before run double click option in the Options menu to verify 
what program will be run when you double click on a particular file type. Setting this 
option is useful for verifying the file associations within Windows. Once you are 
confident that clicking on a file type runs the right program you can reset this option.

    Options Menu
The options for WinSince are:

1) Get file information when start up: If set, WinSince will look for files created 
today in the current directory when WinSince starts. If you do not often want a list of 
the changed files in the current directory then reset this option. Resetting this option 
may save a bit of time at start up if you start in a directory with many files. Use the Get 
Files button to search for files.

2) Warn before run double click: If set, WinSince will present you with a warning 
box when you double click on a file name. The warning box will show the command 
about to be run (such as NOTEPAD.EXE README.TXT if you double click on 
readme.txt). Setting this option is useful for verifying the file associations within 
Windows. Once you are confident that clicking on a file type runs the right program 
you can reset this option.

3) Run program on own when double click: This option is usually set. If reset and 
you double click on a program (.exe, .com, .bat, .pif) you will pass the program name to
the program itself (such as EXCEL.EXE EXCEL.EXE). This is rarely the action 
wanted when you double click on an executable, but it is included for use under special 
circumstances.

When you exit WinSince, the options are saved.



   Hints  and Examples

By customizing the Action buttons you can create a very powerful and easy to use working environment
that can solve virtually any task involving file manipulations and program execution. 

The copy of Since.ini provided with the program provides additional examples of defining the Action 
buttons.

Example: Save today's work to floppy

One of the reasons I wrote WinSince was to be able to see which files had been changed during today's 
work session and to copy them to a floppy for safe keeping.  By selecting a date of Today and using a 
DOS Batch File Action defined as COPY %P\%F A: I can now save today's work to floppy quickly 
and easily. Notice how you have to put the \ in. If there are many files to copy the Pause between and 
Pause at end controls will let you see the individual Action results.

Example: Get a copy of files existing in one directory from a different directory

Suppose you have a directory called C:\FILES with 5 files in it, and another directory C:\NEW\FILES 
with 10 files. The files in C:\FILES need to be set to the contents of C:\NEW\FILES but you don't want 
all 10 files, just the 5 files. Clear the Date, and use the Directory controls to move to the C:\FILES 
directory. Set the Search Type to Search selected directory and press the Get Files button. Use the All 
button to select all 5 files. Then use a DOS Batch File Action defined as COPY C:\NEW\FILES\%F 
C:\FILES

Reclaiming the Original WinSince Actions

If you somehow lose the Action definitions, the original ones programmed into WinSince can be 
returned. Edit the Since.ini file and delete the Action lines in the [Since] section. When you start 
WinSince again the original Actions will be there.

Using the Warning check box to verify Actions and Double Clicks

When first defining an Action, it is useful to set the Warning check box in the Edit screen. This will 
allow you to see what the final command to be run will be, including the file name. To test the new 
Action, select one or more files from the top left list box and run your command. If the command to run
is not as you expected, you can choose "No" and Edit the Action. Once you are satisfied that your new 
Action is working, you can reset the Warning check box.

Similarly, you can use the Options menu to set the "Warn before run double click" option. This will 
show the command to be run when you double click a file name. This is a good way to verify the file 
associations within Windows.

An Action Without a File

You can define an Action that does not need any files. The example supplied with WinSince is the 
running of the Windows Notepad.exe editor without a starting file. When you set up the Action to Do 
leave out any reference to %P, %F, %N and %E. This will allow the Action to start if no files are 
selected. If you do select one or more files then the Action will be performed that many times, but as 
the Action is defined, there will be no file names passed to the program.



Keeping the Selected Files List

You can double click to move to another drive or directory without losing the list of selected files. Only 
when you press the Get Files or Have Files buttons will WinSince get a new list of files.

Keeping the Action Definitions on Screen

If you often enter the Action Edit window to see what the Action definitions are, you can leave it on 
screen while using WinSince. Clicking on the Summary button will hide the edit details, and just show 
the main Action details. You can continue editing by clicking on the Detail button.

Clearing the Date is Important

Using the Clear Date button allows you to search for all files of a particular type, regardless of the file 
creation date. By being able to look across multiple drives and down subdirectory trees, WinSince is a 
powerful tool for finding files.

Temporary Files created by WinSince

WinSince uses a temporary file, SINCE.TMP, to store search information. The location of this file is 
defined by the environment variable TEMP. WinSince is careful enough to check for low disk quota, 
and will notify you if it might run out of free disk space while searching for files. WinSince also creates
a DOS Batch File, SINCETMP.BAT, in the TEMP area.

Developing using Sheridan Software Systems Widgets

WinSince uses one Sheridan runtime VBX file, SS3D2.VBX. If you are developing with Visual Basic 
and this Sheridan VBX file, be sure to close WinSince before opening the VB project. If you do not, VB
will give you the message "Can't load Custom Control DLL: SS3D2.VBX". 

"Sub or Function not defined" error

This error can indicate that the SINCE.DLL or the Visual Basic 2.0 VBRUN200.DLL files are not on 
the path. For simplicity you can put WinSince in the main Windows directory, which is almost always 
on the path. This new version of WinSince has a new SINCE.DLL; any copies of the older SINCE.DLL 
should be deleted.
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	Example: Save today's work to floppy
	One of the reasons I wrote WinSince was to be able to see which files had been changed during today's work session and to copy them to a floppy for safe keeping.  By selecting a date of Today and using a DOS Batch File Action defined as COPY %P%F A: I can now save today's work to floppy quickly and easily. Notice how you have to put the  in. If there are many files to copy the Pause between and Pause at end controls will let you see the individual Action results.
	Example: Get a copy of files existing in one directory from a different directory
	Suppose you have a directory called C:FILES with 5 files in it, and another directory C:NEWFILES with 10 files. The files in C:FILES need to be set to the contents of C:NEWFILES but you don't want all 10 files, just the 5 files. Clear the Date, and use the Directory controls to move to the C:FILES directory. Set the Search Type to Search selected directory and press the Get Files button. Use the All button to select all 5 files. Then use a DOS Batch File Action defined as COPY C:NEWFILES%F C:FILES
	Reclaiming the Original WinSince Actions
	If you somehow lose the Action definitions, the original ones programmed into WinSince can be returned. Edit the Since.ini file and delete the Action lines in the [Since] section. When you start WinSince again the original Actions will be there.
	Using the Warning check box to verify Actions and Double Clicks
	When first defining an Action, it is useful to set the Warning check box in the Edit screen. This will allow you to see what the final command to be run will be, including the file name. To test the new Action, select one or more files from the top left list box and run your command. If the command to run is not as you expected, you can choose "No" and Edit the Action. Once you are satisfied that your new Action is working, you can reset the Warning check box.
	Similarly, you can use the Options menu to set the "Warn before run double click" option. This will show the command to be run when you double click a file name. This is a good way to verify the file associations within Windows.
	An Action Without a File
	You can define an Action that does not need any files. The example supplied with WinSince is the running of the Windows Notepad.exe editor without a starting file. When you set up the Action to Do leave out any reference to %P, %F, %N and %E. This will allow the Action to start if no files are selected. If you do select one or more files then the Action will be performed that many times, but as the Action is defined, there will be no file names passed to the program.
	Keeping the Selected Files List
	You can double click to move to another drive or directory without losing the list of selected files. Only when you press the Get Files or Have Files buttons will WinSince get a new list of files.
	Keeping the Action Definitions on Screen
	If you often enter the Action Edit window to see what the Action definitions are, you can leave it on screen while using WinSince. Clicking on the Summary button will hide the edit details, and just show the main Action details. You can continue editing by clicking on the Detail button.
	Clearing the Date is Important
	Using the Clear Date button allows you to search for all files of a particular type, regardless of the file creation date. By being able to look across multiple drives and down subdirectory trees, WinSince is a powerful tool for finding files.
	Temporary Files created by WinSince
	WinSince uses a temporary file, SINCE.TMP, to store search information. The location of this file is defined by the environment variable TEMP. WinSince is careful enough to check for low disk quota, and will notify you if it might run out of free disk space while searching for files. WinSince also creates a DOS Batch File, SINCETMP.BAT, in the TEMP area.
	Developing using Sheridan Software Systems Widgets
	WinSince uses one Sheridan runtime VBX file, SS3D2.VBX. If you are developing with Visual Basic and this Sheridan VBX file, be sure to close WinSince before opening the VB project. If you do not, VB will give you the message "Can't load Custom Control DLL: SS3D2.VBX".
	"Sub or Function not defined" error
	This error can indicate that the SINCE.DLL or the Visual Basic 2.0 VBRUN200.DLL files are not on the path. For simplicity you can put WinSince in the main Windows directory, which is almost always on the path. This new version of WinSince has a new SINCE.DLL; any copies of the older SINCE.DLL should be deleted.


